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วิชาการออกแบบโปรแกรมใช้คอมพิวเตอร์ช่วย     รหัสวิชา 3000-0206 
ชื่อหน่วย ความรู้คอมพิวเตอร์เบื้องต้น 

 
1. ความหมายของคอมพิวเตอร์ 
 คอมพิวเตอร์ (Computer) คืออุปกรณ์อิเล็กทรอนิคส์ที่มนุษย์ได้เป็นผู้ที่คิดค้นขึ้นมาเพื่อใช้ประโยชน์
ในด้านต่างๆที่ต้องการโดยมีลักษณะการท างานเป็นการรับค าสั่งจากการสั่งการของมนุษย์ผ่านอุปกรณ์รับ
ค าสั่งต่างๆเช่น เมาส์ คีย์บอร์ด แล้วน าไปประมวลผล คิด ค านวณ วิเคราะห์โดยอุปกรณ์ที่เรียกได้ ว่าเป็น
มันสมองของคอมพิวเตอร์คือซีพียู  (Central processing unit: CPU) จากนั้นก็จะแสดงผลผ่านอุปกรณ์ต่างๆ
ออกมาในรูปแบบของข้อมูล อักษร ข้อมูลภาพหรือข้อมูลเสียงตามที่
มนุษย์ต้องการ 
 
 
 

 
 
 

 
รูปที่ 1.1 แสดงชุดคอมพิวเตอร์ (Computer) 

1.1 หลักการท างานของคอมพิวเตอร์ 
ระบบการท างานของคอมพิวเตอร์จะเร่ิมจากหน่วยรับข้อมูล (Input Unit) ท าการรับข้อมูลโดยผ่าน

อุปกรณ์ที่ใช้ในการรับข้อมูลเช่นคีย์บอร์ด (keyboard) เมาส์ (mouse) และส่งข้อมูลให้กับหน่วยประมวลผล
กลาง (Central Processing Unit: CPU) โดยการท างานร่วมกับหน่วยความจ า (memory unit) ท าการค านวณ  
และส่งผลให้หน่วยแสดงผล (Output Unit) ผ่านอุปกรณ์ที่ใช้ในการแสดงผลเช่น จอภาพ ปร้ินเตอร์ ล าโพง 
โดยแต่ละหน่วยสามารถเขียนแผนภาพได้ดังนี้ 
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รูปที่ 1.2 แสดงหลักการท างานของคอมพิวเตอร์ (Computer) 

2. องค์ประกอบของคอมพิวเตอร์ (Computer) 
คอมพิวเตอร์ เป็นอุปกรณ์ที่มนุษย์ได้ประดิษฐ์คิดค้นขึ้นเพื่อน ามาเสริมความสามารถของมนุษย์ใน

ด้านการรับรู้ การจ า การค านวณ การเปรียบเทียบตัดสินใจ และการแสดงออก ดังนั้นคอมพิวเตอร์จึงมี
โครงสร้างที่ประกอบด้วยส่วนต่างๆให้สามารถท างานเป็นระบบสนองความต้องการของมนุษย์ เคร่ือง
คอมพิวเตอร์จะท างานได้นั้นจะต้องประกอบไปด้วย 

2.1 ฮาร์ดแวร์ (Hardware)  
2.2 ซอฟต์แวร์ (Software)  
2.3 พีเพิลแวร์ (People ware)  

2.1 ฮาร์ดแวร ์(Hardware)  
หมายถึงอุปกรณ์ต่างๆที่ประกอบขึ้นเป็นเคร่ืองคอมพิวเตอร์มีลักษณะเป็นโครงร่างสามารถมองเห็น

ด้วยตาและสัมผัสได้เช่น จอภาพ คีย์บอร์ด เคร่ืองพิมพ์ เมาส์ เป็นต้นซึ่งสามารถแบ่งออกเป็นส่วนต่างๆตาม
ลักษณะการท างานได้ 4 ส่วนคือ  

2.1.1 ส่วนรับข้อมูล (Input Unit) 
2.1.2 ส่วนประมวลผลกลาง (Central Processing Unit: CPU)   
2.1.3 ส่วนแสดงผล (Output Unit)  
2.1.4 ส่วนเก็บข้อมูลส ารอง (Secondary Storage)  

โดยอุปกรณ์แต่ละหน่วยมีหน้าที่การท างานแตกต่างกัน  การประมวลผลข้อมูลของคอมพิวเตอร์จะ
ประกอบด้วยอุปกรณ์รับเข้า (input device)  เพื่อรับข้อมูลและค าสั่งจากผู้ใช้ภายนอกเข้าไปเก็บอยู่ในอุปกรณ์
เก็บข้อมูลหรือหน่วยความจ าหลัก (main memory) ค าสั่งที่เก็บในส่วนความจ าหลักจะถูกน าไปตีความและ



สั่งท างานที่หน่วยประมวลผลกลางที่เรียกว่า ซีพียู ซึ่งเป็นสมองของการท างานในคอมพิวเตอร์ท าหน้าที่
ค านวณและเปรียบเทียบข้อมูลที่เก็บในหน่วยความจ าหลัก ผลจากการค านวณหรือประมวลผลจะน ากลับไป
เก็บยังหน่วยความจ าหลัก และพร้อมที่จะน าออกแสดงที่อุปกรณ์ส่งออก (output device) กลับไปสู่ผู้ใช้งาน
คอมพิวเตอร์ต่อไป ดังนั้นระบบคอมพิวเตอร์ประกอบด้วย ซีพียู หน่วยความจ า อุปกรณ์รับเข้า และอุปกรณ์
ส่งออก 
2.1.1 ส่วนรับข้อมูล (Input Unit)  

เป็นอุปกรณ์ที่ท าหน้าที่รับข้อมูลเข้าสู่เคร่ืองคอมพิวเตอร์ในลักษณะของตัวอักษร  (Tex files) ไฟล์
ภาพ ไฟล์เสียง อุปกรณ์รับเข้าที่ใช้กันเป็นส่วนใหญ่คือ คีย์บอร์ด (keyboard) เมาส์ (mouse) สแกนเนอร์ 
(Scanner) ไมโครโฟน  (Microphone) แทร็คบอล (Trackball) จอยสติก (Joystick) จอภาพสัมผัส (Touch 
Screen) กล้องดิจิตอล (Digital Camera) 

 

 
 

รูปที่ 1.3 แสดงอุปกรณ์ส่วนรับข้อมูล (Input Unit) 
2.1.2 หน่วยประมวลผลกลางส่วนประมวลผลกลาง (Central Processing Unit: CPU)  

ท าหน้าที่ในการประมวลผลของระบบคอมพิวเตอร์ประกอบด้วย 2 ส่วนคือส่วนควบคุม (control 
unit) และส่วนค านวณ (arithmetic and logic unit)     

1. ส่วนควบคุม (Control unit)  
ส่วนควบคุมท าหน้าที่ควบคุมการท างานส่วนต่างๆ ของเคร่ืองคอมพิวเตอร์ซึ่งขึ้นอยู่กับการออกแบบเช่น
วิธีการท างานของสัญญาณตามแบบอนุกรมหรือแบบขนาน ชนิดของส่วนความจ า ชนิดของส่วนรับงานและ
แสดงผลฯลฯ ให้ท างานประสานกันและถูกต้องตามขั้นตอนที่ได้รับค าสั่งมา ค าสั่งนี้จะอยู่กับสมมติว่าเรา



เลือกใช้ค าสั่งค าหนึ่งประกอบด้ว ย 18 บิต 6 บิตแรกเป็นค าสั่งให้เคร่ืองท า เช่น บวก ลบ คูณ หาร อ่าน พิมพ์ 
หยุด ฯลฯ เรียกว่า "รหัสค าสั่ง"  

2. ส่วนค านวณ (Arithmetic and logic unit)   
ส่วนค านวณเป็นส่วนประมวลผล ซึ่งนับว่าเป็นส่วนที่ส าคัญที่สุด หรือ "หัวใจ" ของเคร่ืองคอมพิวเตอร์ส่วน
ค านวณท าหน้าที่ ใหญ่ๆสองประการคือ ประการแรกท าการบวก ลบ คูณ และหาร ประการที่สองคือ ท า
หน้าที่ตัดสินใจว่าข้อมูลใหญ่หรือเล็กกว่าอีกข้อมูลหนึ่ง หน้าที่ทั้งสองประการน้ีสามารถปฏิบัติการเป็น
ผลส าเร็จได้โดยอาศัยวงจรตรรกะอันเป็นวงจรอิเล็กทรอนิกส์ จึงท าให้ส่วนค านวณนี้มีชื่อเรียกอีกอ ย่างหนึ่ง
ว่า ส่วนค านวณตรรกะ (arithmetic logic unit; ALU) นอกจากนี้ ส่วนค านวณสามารถเลื่อนข้อมูลไปทางซ้าย 
หรือทางขวา เก็บหรือย้ายข้อมูลไปยังส่วนอ่ืน ๆของส่วนควบคุมกลางได้  

 

                     
 

รูปที่ 1.4 แสดงอุปกรณ์ส่วนประมวลผลกลาง (Central Processing Unit: CPU)  
อุปกรณ์ในส่วนประมวลผลกลาง (Processing) 
1. เมนบอร์ด (Main Board)  

เมนบอร์ดคือแผงวงจรขนาดใหญ่ที่สุดในเคร่ืองท าหน้าที่เชื่อมต่ออุปกรณ์ต่างๆเช่นแรม  ซีพียู การ์ด
เสียง การ์ดจอภาพและอื่นๆถ้าถามว่าในคอมพิวเตอร์  อะไรส าคัญที่สุด  ค าตอบที่ออกมาเป็นเสียงเดียวกันก็
คือ ซีพียู  รองลงมาคือหน่วยความจ าหลัก  แผงวงจรหลักหรือที่รู้จักกันในชื่อของเมนบอร์ด  (Main Board, 
Mother Board) หรืออาจเรียกทับศัพท์ภาษาอังกฤษว่ามาเธอร์บอร์ดก็ได้ตามแต่สะดวก  ไม่มีข้อห้าม  แต่
ทั้งหมดนั้นหมายถึงอุปกรณ์ชิ้นเดียวกัน ที่เป็นแผงรวมวงจรอิเลคทรอนิคส์อยู่ในตัวเคส ของคอมพิวเตอร์  ที่
ใหญ่ที่สุด เพราะในคอมพิวเตอร์  แผงวงจรอ่ืนๆจะใหญ่กว่าเมนบอร์ดเป็นไม่มี  คราวนี้ก็ลองเปิดฝาครอบเค
สมาออกดู มองลงไปจะเห็นแผงวงจรมองใหญ่ๆ แผงหนึ่ง นั่นแหละคือแผง เมนบอร์ด (Main Board) 

 



 
 

รูปที่ 1.5 แสดงอุปกรณ์เมนบอร์ด (MAIN BOARD) 
หน้าท่ีของเมนบอร์ด 

 การท างานของคอมพิวเตอร์  เป็นการน าเอาส่วนประกอบต่างๆของอุปกรณ์อิเล็กทรอนิกส์มา
ประกอบเข้าด้วยกันโดยการเชื่อมต่อกันด้วยรูปแบบในลักษณะต่างๆเมนบอร์ดนั้นเปรียบเสมือนแผนที่น า
ทางที่ประกอบด้วยถนนมากมายซึ่งก็คือเส้นทางเดินของข้อมูลในระบบของคอมพิวเตอร์นั้นเอง  
ชนิดของเมนบอร์ดแบ่งเป็น 4 ชนิดคือ 

1. แบบ AT เป็นเมนบอร์ดที่มีความกว้างและความยาวใกล้เคียงกันคล้ายสี่เหลี่ยมผืนผ้า ขั้วรับไฟมี 
12 ขา การปิด เคร่ืองใช้สวิทซ์เป็นตัวควบคุม 

2. แบบ ATX เป็นเมนบอร์ดมาตรฐานใหม่ ลักษณะ คล้ายกับ AT แต่ขนาดเล็กกว่า เมนบอร์ดรุ่นนี้
ได้รับการออกแบบ ให้ซีพียูและหน่วยความจ าอยู่ใกล้กัน ตลอดจนซีพียูถูกวางไว้ใกล้กับพัดลมระบายความ
ร้อน นอกจากนี้ ยังก าหนดต าแหน่งและสีของช่องส าหรับอุปกรณ์ต่อไว้ต่างกันเพื่อให้จดจ าง่าย รวมทั้ง
สามารถสั่งปิดเคร่ืองจากระบบปฏิบัติการโดยไม่ต้องกดสวิทซ์มีขนาด 12 นิ้ว x 9.6 นิ้ว 

3. แบบ Micro ATX ลักษณะคล้ายกับรุ่น ATX แต่ลดจ านวนสล๊อตเหลือเพียง 3 – 4 สล๊อต เพื่อท า
ให้ราคาจ าหน่ายถูกลงมีขนาดเพียง 9.6 นิ้ว คูณ 9.6นิ้ว 

4. แบบ Flex ATX เป็นเมนบอร์ดแบบ ATX ที่มีขนาดเล็กที่สุด เมนบอร์ดชนิดนี้มักมีอุปกรณ์ 
Onboard มาด้วยตอนผลิตขนาดเมนบอร์ดเพียง 9 นิ้วคูณ 7.5 นิ้ว 
 
2. ซีพียู (CPU)  

เป็นอุปกรณ์ที่ส าคัญที่สุดของคอมพิวเตอร์ท าหน้าที่คิดค านวณและประมวลผลในส่วนประมวลผลกลาง  
(Central Processing Unit: CPU) ซึ่งเปรียบเสมือนสมองของคอมพิวเตอร์ 

 



                                      
 

 รูปที่ 1.6 แสดงอุปกรณ์ส่วนประมวลผลกลาง (Central Processing Unit: CPU)  
3. การ์ดแสดงผล (Graphic Card) 
  ท าหน้าที่แปลงข้อมูลต่างๆเป็นภาพสู่หน้าจอของคอมพิวเตอร์  เป็นตัวก าหนดความสมบูรณ์ของ
ภาพออกสู่จอภาพเพราะการ์ดนี้จะต้องมีความสัมพันธ์กับเมนบอร์ดว่ารองรับเทคโนโลยีการแสดงภาพถึงรุ่น
ใดเป็น AGP หรือไม่และในการ์ดนี้มีแรม (หน่วยความจ า ) ใช้ในการเก็บข้อมูลที่ส่งมาจากซีพียูก่อนแสดง
ภาพหรือไม่  ถ้ามีมากจะท าให้การ์ดแสดงภาพมีควา มละเอียดของภาพสูง จะคมชัดขนาด (Size) มีความ
จ าเป็นส่วนหน่ึงในการแสดงขนาดของภาพ ขนาดจอภาพมีตั้งแต่ 5-30 นิ้ว โดยการวัดมุมเส้น ทแยงมุม มอง
ด้านในที่ใช้การแสดงภาพ  

 
 
 

 
 
 

 
 
รูปที่ 1.7 แสดงอุปกรณก์าร์ดแสดงผล (Graphic Card) 

 
4. การ์ดเสียง (Sound Card)  

การ์ดเสียง (Sound Card) ท าหน้าที่ประมวลผลสร้างสัญญาณเสียงเพื่อส่งออกไปยังล าโพงการ์ดเสียง 
หรือ ซาวน์การ์ด (sound card) คืออุปกรณ์ คอมพิวเตอร์ ที่ท าหน้าที่แปลงข้อมูลดิจิทัลที่เก็บรายละเอียด
เกี่ยวกับเสียงต่างๆ แปลงเป็นสัญญาณเสียงในรูปสัญญาณทางไฟฟ้า 

 
 
 

http://th.wikipedia.org/wiki/%E0%B8%84%E0%B8%AD%E0%B8%A1%E0%B8%9E%E0%B8%B4%E0%B8%A7%E0%B9%80%E0%B8%95%E0%B8%AD%E0%B8%A3%E0%B9%8C


 
 
 
 
 

รูปที่ 1.8 แสดงอุปกรณ์การ์ดเสียง (Sound Card) 
 
2.1.3 ส่วนแสดงผล (Output Unit) 

เป็นอุปกรณ์ท าหน้าที่น าผลการประมวลผลของซีพียูมา แสดงให้ผู้ใช้ได้เห็นได้หลายรูปแบบทั้งภาพ 
เสียง กระดาษ ขึ้นอยู่กับความต้องการน าอุปกรณ์ประเภทใดเข้าไปติดต้ังให้เคร่ืองคอมพิวเตอร์แสดงค่า
เอาท์พุทออกมาเช่น จอภาพ ปร้ินเตอร์ ล าโพง 

 
 

รูปที่ 1.9 แสดงอุปกรณ์ส่วนแสดงผล (Output Unit) 
2.1.4 ส่วนเก็บข้อมูลส ารอง (Secondary Storage)  

ใช้เป็นส่วนเพิ่มหน่วยความจ าให้มีขนาดใหญ่มากขึ้น ท างานติดต่อยู่กับส่วนความจ าหลัก  โดยปกติ
แล้วหน่วยความจ าส ารองจะมีความจุมากและมีราคาถูกกว่าหน่วยความจ าหลัก  แต่เรียกหาข้อมูลได้ช้ากว่า 
เช่น ฮาร์ดดิสก ์ฟล็อบปี้ดิสก์ 

 
                           รูปที่ 1.10 แสดงอุปกรณ์ส่วนเก็บข้อมูลส ารอง (Secondary Storage) 
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2.2 ซอฟต์แวร์ (Software) หมายถึงส่วนที่ท าหน้าที่เป็นค าสั่งที่ใช้ควบคุมการท างานของเคร่ืองคอมพิวเตอร์  
หรืออาจเรียกว่า “โปรแกรม” ก็ได้ ซึ่งหมายถึง ค าสั่งหรือชุดของค าสั่ง  ซึ่งสามารถใช้เพื่อสั่งให้คอมพิวเตอร์
ท างาน เราต้องการให้เคร่ืองคอมพิวเตอร์ท าอะไร  ก็เขียนเป็นค าสั่ง ซึ่งจะต้องสั่งเป็นขั้นเป็นตอน  และแต่ละ
ขั้นตอนต้องท าอย่างละเอียดและครบถ้วน  ซึ่งจะเกิดเป็นงานชิ้นหนึ่งขึ้นมามีชื่อเรียกว่า โปรแกรม  ผู้ที่เขียน
โปรแกรมดังกล่าวก็จะเรียกว่า นักเขียนโปรแกรม (Programmer) ส าหรับการเขียนโปรแกรมนั้นจะต้องใช้
ภาษาที่ใช้ในการเขียนโปรแกรมโดยเฉพาะ  ซึ่งหมายถึง ภาษาที่เคร่ืองคอมพิวเตอร์สามารถเข้าใจได้ เช่น 
ภาษาเบสิก ภาษาโคบอล ภาษาปาสคาล เป็นต้น โปรแกรมที่เขียนขึ้นมาก็จะน า ไปใช้ในงานเฉพาะอย่าง เช่น  
โปรแกรมสต็อกสินค้าคงคลัง โปรแกรมค านวณภาษี โปรแกรมคิดเงินเดือนพนักงาน เป็นต้น 
2.2.1 โปรแกรมระบบปฏิบัติการ (Operating System)  

ท าหน้าที่ในการควบคุมอุปกรณ์ฮาร์ดแวร์ให้ท างานและตรวจสอบความผิดพลาด ของอุปกรณ์ที่อยู่
ในเคร่ืองคอมพิวเตอร์แล ะอุปกรณ์ต่อพ่วงต่างๆ โดยแจ้งความผิดพลาด  (ERROR) เมื่อเกิดความผิดพลาด
ขึ้นมา  
2.2.2 ซอฟท์แวร์ใช้งาน (Applications software) 

แอพพลิเคชั่น ซอฟท์แวร์ เป็นโปรแกรมที่สร้างหรือพัฒนามาเพื่อน ามาใช้งานเฉพาะด้านอยู่ในรูป
ของโปรแกรมส าเร็จรูปหรือเรียกอีกอย่างหนึ่งว่า แพ็คเก็ตซอฟท์แวร์ (Packet Software) ในปัจจุบันเรา
สามารถแบ่งชนิดของแอพพลิเคชั่นซอฟท์แวร์ ตามลักษณะจุดประสงค์ของแต่ละโปรแกรมได้ดังนี ้

โปรแกรมประมวลผลค า (Word Processor) สร้างขึ้นมาใช้ท างานด้านการสร้างเอกสาร ต่างๆ เช่น
โปรแกรม Microsoft Word 

โปรแกรมตารางค านวณ (Spreadsheet) เป็นโปรแกรมใช้ในการค านวณตัวเลขในรูปของตาราง  
รวมทั้งน าค่าที่ได้ออกมาแสดงผลในรูปกราฟ 

โปรแกรมด้านฐานข้อมูล (Data Base) เป็นโปรแกรมใช้ในการเก็บฐานข้อมูลเช่น ประวัติลูกค้า หรือ
ฐานข้อมูลประวัติการซ่อมเคร่ืองต่างๆเช่น โปรแกรม  Microsoft Access 

โปรแกรมด้านกราฟฟิกส์ (Graphics) ใช้งานด้านรูปภาพต่างๆเช่นโปรแกรม Photoshopโปรแกรม
อินเทอร์เน็ต (Internet) เป็นซอฟท์แวร์ที่ใช้ในการค้นหา แลกเปลี่ยน ดึงข้อมูลใน  

ระบบเครือข่ายมาใช้งานเช่นโปรแกรม Internet Explorer 
โปรแกรมอรรถประโยชน์ (Utility) เป็นโปรแกรมที่สร้างขึ้นมาเพื่อช่วยเหลือการท างาน 

ด้านต่างๆของผู้ใช้ด้านคอมพิวเตอร์ให้มีความสะดวกในการแก้ปัญหาระบบเช่นโปรแกรม Norton Antivirus 
โปรแกรมด้านบันเทิง (Entertainment) เป็นซอฟท์แวร์สร้างมาเพื่อท าหน้าที่เล่นแผ่น CD, VCD, 

DVD ต่างๆเช่นโปรแกรม Power DVD  
 
 
 



2.3 พีเพิ้ลแวร์ (People ware)  
หมายถึงบุคลากรในงานด้านคอมพิวเตอร์  ซึ่งมีความรู้เกี่ยวกับคอมพิวเตอร์สามารถใช้งาน  สั่งงาน

เพื่อให้คอมพิวเตอร์ท างานตามที่ต้องการ บุคคลที่มีหน้าที่เกี่ยวข้องกับคอมพิวเตอร์เช่น พนักงานป้อนข้อมูล , 
นักเขียนโปรแกรม, นักวิเคราะห์ระบบ ทั้งสามส่วนน้ีเป็นส่วนประกอบที่ส าคัญของคอมพิวเตอร์ถ้าขาดส่วน
หนึ่งส่วนใดไปแล้ว คอมพิวเตอร์ก็จะไม่สามารถใช้งานได้เลยบุคคลแบ่งออกได้ 4 ระดับ ดังนี ้

2.3.1 ผู้จัดการระบบ  (System Manager) ผู้วางนโยบายการใช้คอมพิวเตอร์ให้เป็นไปตามเป้าหมาย
ของหน่วยงาน 

2.3.2 นักวิเคราะห์ระบบ  (System Analyst) ผู้ที่ศึกษาระบบงานเดิมหรืองานใหม่และท าการวิเคราะห์
ความเหมาะสม  ความเป็นไปได้ในการใช้คอมพิวเตอร์กับระบบงาน  เพื่อให้โปรแกรมเมอร์เป็นผู้เขียน
โปรแกรมให้กับระบบงาน 

2.3.3 โปรแกรมเมอร์  (Programmer) ผู้เขียนโปรแกรมสั่งงานเคร่ืองคอมพิวเตอร์เพื่อให้ท างานตาม
ความต้องการของผู้ใช้ โดยเขียนตามแผนผังที่นักวิเคราะห์ระบบได้เขียนไว้ 

2.3.4 ผู้ใช้  (User) ผู้ใช้งานคอมพิวเตอร์ทั่วไป  ซึ่งต้องเรียนรู้วิธีการใช้เคร่ือง และวิธีการใช้งาน
โปรแกรม  เพื่อให้โปรแกรมที่มีอยู่สามารถท างานได้ตามที่ต้องการ  เน่ืองจากเป็นผู้ก าหนดโปรแกรมและใช้
งานเคร่ืองคอมพิวเตอร์  มนุษย์จึงเป็นตัวแปรส าคัญในอันที่จะท าให้ผลลัพธ์  
มีความน่าเชื่อถือ  เน่ืองจากค าสั่งและข้อมูลที่ใช้ในการประมวลผลได้รับจากการก าหนดของมนุษย์  (People 
ware) ทั้งสิ้น 
 
3. ประเภทของคอมพิวเตอร์  

คอมพิวเตอร์แบ่งตามความสามารถของระบบจ าแนกออกได้เป็น 4 ชนิด โดยพิจารณาจาก
ความสามารถในการเก็บข้อมูล และ ความเร็วในการประมวลผล เป็นหลัก ดังนี้ 
3.1 ซุปเปอร์คอมพิวเตอร์ (Super Computer) 

หมายถึง เคร่ืองประมวลผลข้อมูลที่มีความสามารถในการประมวลผลสูงที่สุด  โดยทั่วไปสร้างขึ้น
เป็นการเฉพาะเพื่องานด้านวิทยาศาสตร์ที่ต้องการการประมวลผลซับซ้อน  และต้องการความเร็วสูง เช่น 
งานวิจัยขีปนาวุธ งานโครงการอวกาศสหรัฐ (NASA) งานสื่อสารดาวเทียม หรืองานพยากรณ์อากาศ เป็นต้น 
3.2 เมนเฟรมคอมพิวเตอร์ (Mainframe Computer) 

หมายถึงเคร่ืองประมวลผลข้อมูลที่มีส่วนความจ าและความเร็วน้อยลงสามารถใช้ข้อมูลและค าสั่ง
ของเคร่ืองรุ่นอ่ืนในตระกูล (Family) เดียวกันได้  โดยไม่ต้องดัดแปลงแก้ไขใดๆ นอกจากนั้นยังสามารถ
ท างานในระบบเครือข่าย (Network) ได้เป็นอย่างดี โดยสามารถเชื่อมต่อไปยังอุปกรณ์ที่เรียกว่า เคร่ือง
ปลายทาง  (Terminal) จ านวนมากได้ สามารถท างานได้พร้อมกันหลายงาน (Multi Tasking) และใช้งานได้
พร้อมกันหลายคน (Multi User) ปกติเคร่ืองชนิดนี้นิยมใช้ในธุรกิจขนาดใหญ่  มีราคาต้ังแต่สิบล้านบาทไป



จนถึงหลายร้อยล้านบาท  ตัวอย่างของเคร่ืองเมนเฟรมที่ใช้กันแพร่หลายก็คือ  คอมพิวเตอร์ของธนาคารที่
เชื่อมต่อไปยังตู้ ATM และสาขาของธนาคารทั่วประเทศนั่นเอง  
3.3 มินิคอมพิวเตอร์ (Mini Computer) 

ธุรกิจและหน่วยงานที่มีขนาดเล็กไม่จ าเป็นต้องใช้คอมพิวเตอร์ขนาดเมนเฟรมซึ่งมีราคาแพง  ผู้ผลิต
คอมพิวเตอร์จึงพัฒนาคอมพิวเตอร์ให้มีขนาดเล็กและมีราคาถูกลง เรียกว่า  เคร่ืองมินิคอมพิวเตอร์  โดยมี
ลักษณะพิเศษในการท างานร่วมกับอุปกรณ์ประกอบรอบข้างที่มีความเร็วสูง ได้ มีการใช้แผ่นจานแม่เหล็ก
ความจุสูงชนิดแข็ง (Hard disk) ในการเก็บรักษาข้อมูล  สามารถอ่านเขียนข้อมูลได้อย่างรวดเร็ว หน่วยงาน
และบริษัทที่ใช้คอมพิวเตอร์ขนาดน้ี  ได้แก่ กรม กอง มหาวิทยาลัย ห้างสรรพสินค้า โรงแรม โรงพยาบาล  
และโรงงานอุตสาหกรรมต่างๆ 
3.4 ไมโครคอมพิวเตอร์ (Micro Computer) 

หมายถึง เคร่ืองประมวลผลข้อมูลขนาดเล็ก  มีส่วนของหน่วยความจ าและความเร็วในการ
ประมวลผลน้อยที่สุด  สามารถใช้งานได้ด้วยคนเดียว จึงมักถูกเรียกว่า คอมพิวเตอร์ส่วนบุคคล (Personal 
Computer: PC) ปัจจุบัน ไมโครคอมพิวเตอร์มีประสิทธิภาพสูงกว่าในสมัยก่อนมาก  อาจเท่ากับหรือมากกว่า
เคร่ืองเมนเฟรมในยุคก่อน นอกจากนั้นยังราคาถูกลงมาก  ดังนั้นจึงเป็นที่นิยมใช้มาก ทั้งตามหน่วยงานและ
บริษัทห้างร้าน ตลอดจนตามโรงเรียน  สถานศึกษา และบ้านเรือน  บริษัทที่ผลิตไมโครคอมพิวเตอร์
ออกจ าหน่ายจนประสบความส าเร็จเป็นบริ ษัทแรก คือ  บริษัทแอปเปิลคอมพิวเตอร์เคร่ือง
ไมโครคอมพิวเตอร์ จ าแนกออกได้เป็นแบบติดตั้งใช้งานอยู่กับที่บนโต๊ะท างาน (Desktop Computer) และ
แบบเคลื่อนย้ายได้ (Portable Computer) สามารถพกพาติดตัว อาศัยพลังงานไฟฟ้าจากแบตเตอร่ีจากภายนอก 
ส่วนใหญ่มักเรียกตามลักษณะของการใช้งานว่า Laptop Computer หรือ Notebook Computer 
4. ประโยชน์ของคอมพิวเตอร์  

คอมพิวเตอร์  (Computer) ได้ให้ประโยชน์กับมนุษย์อย่างมากมายซึ่งเรียกได้ว่าคอมพิวเตอร์มีส่วน
อย่างมากในการพัฒนาความรู้ความสามารถอย่างหลากหลายจากการที่คอมพิวเตอร์มีลักษณะเด่นหลาย
ประการ ท าให้ถูกน ามาใช้ประโยชน์ต่อการด าเนินชีวิตประจ าวันในสังคมเป็นอย่างมาก  ที่พบเห็นได้บ่อย
ที่สุดก็คือ การใช้ในการพิมพ์เอกสารต่างๆ เช่น พิมพ์จดหมาย รายงาน  เอกสารต่างๆ ซึ่งเรียกว่างาน
ประมวลผล (Word processing) โดยเราแบ่งลักษณะการใช้ประโยชน์ได้ดังนี้ 
4.1 ใช้คอมพิวเตอร์ (Computer) เพื่อการค้นหาข้อมูล 

เน่ืองจากคอมพิวเตอร์ในปัจจุบัน   มักจะมีการเชื่อมต่อกับโลกแห่งเครือข่ายนั่น  คืออินเทอร์เน็ต
นั่นเอง   ซึ่งอินเทอร์เน็ตนับว่าเป็นแหล่งข้อมูลต่างๆ ที่ใหญ่ที่สุด  แลรวมเอาเน้ือหาความรู้ในโลกไว้มาก
ที่สุด   เราสามารถใช้ประโยชน์ จากอินเทอร์เน็ตได้อย่างมากมาย  การศึกษา ได้แก่ การใช้คอมพิวเตอร์
ทางด้านการเรียนการสอน ซึ่งมีการน าคอมพิวเตอร์มาช่วยการสอนในลักษณะบทเรียน CAI (Computer - 
Assisted- Instruction) หรืองานด้านทะเบียนงานวิศวกรรมและสถาปัตยกรรม สถาปนิกและวิศวกรสามารถ
ใช้คอมพิวเตอร์ในการออกแบบ  



4.2 ใช้คอมพิวเตอร์ (Computer) เพื่อความบันเทิง 
คอมพิวเตอร์ปัจจุบันสามารถใช้สร้างความบันเทิง  ให้กับผู้เป็นเจ้าของได้หลายรูปแบบไม่ว่าจะเป็น

การดูหนัง ฟังเพลง เล่นเกม ร้องคาราโอเกะการเล่นเกมส์ผ่านอินเตอร์เน็ต  นับว่าเป็นแหล่งความบันเทิงครบ
ชุดที่หาได้อย่างมากมายในปัจจุบัน  
4.3  ใช้คอมพิวเตอร์ (Computer) เพื่องานเอกสาร 

เป็นการน าเอาคอมพิวเตอร์มาใช้ในการพิมพ์ เช่น การพิมพ์เอกสาร  การพิมพ์จดหมายการพิมพ์
ใบปลิว   การพิมพ์หนังสือ แบบเรียน   เป็นต้น  การใช้คอมพิวเตอร์เข้ามาช่วยงานในด้านการพิมพ์นี้ท าให้
เอกสารต่างๆ  มีความสวยงาม  และรวดเร็วมากขึ้น รวมถึงงานพิมพ์มีความผิดพลาดน้อยมาก  และมีการใช้
แบบฟอร์มเดียวกัน จึงท าให้งานด้านการพิมพ์เป็นระเบียบเรียบร้อยมากขึ้น 
4.4  ใช้คอมพิวเตอร์ (Computer) เพื่องานเฉพาะด้าน 

คอมพิวเตอร์ด้านการแพทย์  งานด้านวิศวกรรมและสถาปัตยกรรม สถาปนิกและวิศวกรสามารถใช้
คอมพิวเตอร์ในการออกแบบ  เขียนแบบ งานด้านการตัดต่อภาพยนตร์งานด้าน การเขียนโปรแกรมควบคุม
การท างานของหุ่นยนต์ในโรงงานอุตสาหกรรมต่างๆ  
 
บทสรุป 

เคร่ืองคอมพิวเตอร์ที่สามารถที่จะท างานได้ต้องประกอบด้วยอุปกรณ์ในส่วนที่สามารถมองเห็นได้
ที่เรียกว่า ฮาร์ดแวร์ (Hardware), ซอฟต์แวร์ (Software) และพีเพิลแวร์ (People ware)  
ฮาร์ดแวร์ (Hardware) แบ่งการท างานออกเป็น 4 ส่วน  
        1. ส่วนรับข้อมูล (Input Unit) 
        2. ส่วนประมวลผลกลาง (Central Processing Unit: CPU)   
        3. ส่วนแสดงผล (Output Unit)  
        4. ส่วนเก็บข้อมูลส ารอง (Secondary Storage)  
 ซอฟต์แวร์ (Software) หรือโปรแกรมคอมพิวเตอร์แบ่งเป็น 
        1. โปรแกรมระบบปฏิบัติการ (Operating System) 
        2. โปรแกรมซอฟท์แวร์ใช้งาน (Applications software) 
 พีเพิลแวร์ (People ware) ระดับของผู้ใช้คอมพิวเตอร์แบ่งได้ดังนี้ 
       1. ผู้จัดการระบบ (System Manager) 
       2. นักวิเคราะห์ระบบ (System Analyst) 
       3. โปรแกรมเมอร์ (Programmer) 
       4. ผู้ใช้ (User) 
 
 



ใบเนื้อหา 
เวลา 240 นาที วิชาการออกแบบโปรแกรมใช้คอมพิวเตอร์ช่วย     รหัสวิชา 3000-0206 

ชื่อหน่วย เร่ิมต้นเขียนแบบกับโปรแกรม AutoCAD 
 
1. การก าหนดเงื่อนไขในการเขียนแบบ  

การก าหนดเงื่อนไขในการเขียนแบบในเร่ืองนี้จะกล่าวถึงการใช้ค าสั่งที่จ าเป็นในการเร่ิมต้นเขียน
แบบซึ่งเป็นสิ่งส าคัญที่จะต้องมีการต้ังค่าทุกครั้งที่มีการเขียนแบบคือ 

1.1 การก าหนดขอบเขตหรือพื้นที่ส าหรับเขียนแบบ (Drawing Limits) 

1.2 การก าหนดค่าหน่วย (Units) ในการเขียนแบบ 

1.3 การก าหนดค่าของ Drafting Settings 

1.1 การก าหนดขอบเขตของการเขียนแบบ (Drawing Limits)  

ในการเขียนแบบจะก าหนดค่าพื้นที่หรือขอบเขตของแบบ (เปรียบได้กับการเลือกขนาดของ
กระดาษ) ให้มีขนาดใกล้เคียงกับขนาดของชิ้นงานจริง เช่นถ้าต้องการเขียนชิ้นงานที่มีขนาด  200 X 100 ม.
ม. จะก าหนดขอบเขตหรือพื้นที่ส าหรับเขียนแบบ ให้มีพิกัดมุมล่างซ้ายเป็น X = 0 และ Y = 0  และพิกัดมุม
บนขวาเป็น X = 300, Y = 150 โดยใช้ค าสั่ง Drawing Limits ส าหรับก าหนดขอบเขต และใช้ค าสั่ง Zoom All  
เพื่อปรับการแสดงผลของหน้าจอให้มีพิกัดและพื้นที่เขียน แบบให้เหมาะสมกับขอบเขตของงานเขียนแบบ
  

การก าหนดขอบเขตของแบบให้มีพื้นที่ตามต้องการมีดังนี้  
1. ที่ Menu bar คลิกที่ Format > drawing Limits 

 

 
รูปที่ 3.1 แสดงการก าหนดขอบเขตของการเขียนแบบ 

 

เลือก Format > drawing Limits คลิก 



2. ที่ Command Line ให้พิมพ์พิกัดมุมล่างซ้าย X = 0, Y = 0 โดยมีรูปแบบการพิมพ์เป็น 0, 0  
    แล้วกดคีย์  Enter       

 
 

รูปที่ 3.2 แสดงการพิมพ์พิกัดมุมล่างซ้าย 
3. ที่ Command Line ให้พิมพ์พิกัดมุมบนขวา  X = 300 และ Y = 150  โดยมีรูปแบบการพิมพ์เป็น 
   300,150 แล้วกดคีย์ Enter 

 
 
   รูปที่ 3.3 แสดงการพิมพ์พิกัดมุมบนขวา 

4. คลิกเมนู View>Zoom>All หรือคลิก Zoom All  ที่ Standard Toolbars เพื่อปรับขนาดจอภาพให้เหมาะสม
กับขอบเขตของงานเขียนแบบตามต้องการ 

 

 
 

รูปที่ 3.4 แสดงการปรับขนาดจอภาพ 
 

พิมพ ์X = 0, Y = 0 

 

พิมพ ์X = 300, Y = 150 

 

เลือก View > Zoom > All  แล้วคลิก 
คลิก 
 



1.2 การก าหนดค่าหน่วย (Units) ในการเขียนแบบ 
ค าสั่ง Units เป็นค าสั่งที่ใช้ส าหรับก าหนดจ านวนจุดทศนิยมและหน่ายของชิ้นงานที่ใช้ในการเขียน

แบบเช่นมีจุดทศนิยม 2 ต าแหน่งและมีหน่วยเป็นน้ิวท าได้ดังนี้ 
การก าหนดหน่วยและทศนิยมมีดังนี้ 

1. ที่ Menu bar คลิกเมนู Format>Units… 
 

 
 

รูปที่ 3.5 แสดงการก าหนดค่าหน่วย (Units) 
2. ได้ไดอะล็อกบ๊อกซ์ Drawing Units บริเวณกรอบ Length ที่ช่อง Type ให้เลือก Decimal  

     และที่ช่อง Precision ให้เลือกจ านวนทศนิยมที่ต้องการ 
 

 
 
รูปที่ 3.6 แสดงการเลือกจ านวนทศนิยม 

 
 

เลือก Format > Units… แล้วคลิก 
คลิก 
 

เลือกจ านวนทศนิยม 
คลิก 
 

คลิก 
คลิก 
 



3. ในกรอบ Angle ที่ช่อง Type ให้เลือก Decimal Degrees และที่ช่อง Precision ให้เลือกจ านวน 
     ทศนิยมที่ต้องการ 

 

 
 
รูปที่ 3.7 แสดงการเลือกจ านวนทศนิยม 

4. ที่ช่อง Units to scale inserted content ให้เลือก Meters ส าหรับชิ้นงานที่มีหน่วยเป็นเมตรหรือ 
    Millimeters ส าหรับหน่วยที่เป็นมิลลิเมตร 

 

 
 
รูปที่ 3.8 แสดงการเลือกหน่วย 

5. คลิกปุ่ม OK 
 

 

คลิก 
คลิก 
 

เลือกจ านวนทศนิยม 
คลิก 
 

เลือกหน่วย 
คลิก 
 



1.3 การก าหนดค่าของ Drafting Settings 

 Drafting Settings  เป็นค าสั่งที่ใช้ก าหนดค่า Grid และ Snap เพื่อช่วยให้เขียนแบบได้รวดเร็วและ
แม่นย ามากขึ้นสามารถก าหนดขนาดความกว้างของ Grid และระยะการกระโดดของ Snap ได้ดังนี ้

การก าหนดขนาดของ Grid และ Snap  
1. ที่ Menu bar คลิกที่เมนุ Tool >Drafting Settings  
 

 
 
รูปที่ 3.9 แสดงการก าหนดค่าของ Drafting Settings 

2. ได้ไดอะล็อกบ๊อกซ์ Drafting Settings ให้คลิกแท็ป Snap and Grid  
 

 
 
รูปที่ 3.10 แสดงการก าหนดขนาดของ Grid และ Snap 

 
 

คลิกที่เมนุ Tool > Drafting Settings 

Settings คลิก 
 

คลิก 
 

คลิก 
 



3. คลิกให้มีเคร่ืองหมายถูกในช่องสี่เหลี่ยมหน้า Grid On (F7) และก าหนดค่าดังนี้ 
ที่ช่อง Grid x spacing ให้พิมพ์ค่าระยะห่างของ Grid ตามแกน X เช่น 10 
ที่ช่อง Grid y spacing ให้พิมพ์ค่าระยะห่างของ Grid ตามแกน Y เช่น 10 
 

 
 

รูปที่ 3.11 แสดงการก าหนดขนาดของ Grid 
4. คลิกให้มีเคร่ืองหมายถูกในช่องสี่เหลี่ยมหน้า Snap On (F9) และก าหนดค่าดังนี้ 

ที่ช่อง Snap x spacing ให้พิมพ์ค่าระยะห่างของ Snap ตามแกน X เช่น 10 
ที่ช่อง Snap y spacing ให้พิมพ์ค่าระยะห่างของ Snap ตามแกน Y เช่น 10 
 

 
รูปที่ 3.12 แสดงการก าหนดขนาดของ Snap 

5. คลิกปุ่ม OK 

เลือก 
Drafting 
Settings 

คลิก 
 

คลิก  
 

คลิก  
 

เลือก 
 



ลักษณะของจุด Grid และ Snap 
Grid เป็นการสร้างจุดบนพื้นที่หน้าจอที่ใช้ในการเขียนแบบเหมือนกับการเขียนแบบบนกระดาษ

กราฟซึ่งจะเป็นการช่วยเพิ่มความสะดวกในการก าหนดต าแหน่ง และประมาณระยะต่างๆได้ตามต้องการ 
  Snap เป็นการก าหนดการเคลื่อนที่ของ Crosshair cursor เมื่อมีการเคลื่อนที่ของเมาส์ตามที่ก าหนด
ไว้ทั้งในแนวแกน X และ Y (เปรียบเสมือนแม่เหล็กที่ดูดค่าพิกัดวิ่งเข้าหาจุดของ Snap) 
 

 
 

รูปที่ 3.13 แสดงลักษณะของจุด Grid และ Snap 
2. การเขียนภาพในแบบ Isometric  
  ในกรณีที่ต้องการเขียนภาพ Isometric ที่บริเวณกรอบ Snap type ให้คลิกให้มีเคร่ืองหมายถูกในช่อง
สี่เหลี่ยมหน้า Isometric snap และถ้าต้องการยกเลิกให้คลิกเอาเคร่ืองหมายถูกออกจากช่องสี่เหลี่ยม 

 
การตั้งค่าในการปรับภาพดังนี้  

1. ที่ Menu bar คลิกที่แท็ป Tools คลิกเลือก Drafting Settings 
 

ลักษณะของจุด Grid และระยะ Snap 

Settings คลิก 
 



 
 

รูปที่ 3.14 แสดงการคลิกเลือก Drafting Settings 
2. ที่หน้าต่าง Drafting Settings ที่ช่อง Snap Type คลิกเลือกให้มีเคร่ืองหมายที่ช่อง Isometric snap และคลิก 
OK 
 

 
 
รูปที่ 3.15 แสดงการปรับภาพแบบ Isometric 

 
 
 
 

คลิกเลือก Drafting Settings  
 

คลิกเลือก 

คลิก 



3. ได้หน้าต่างของการเขียนแบบในแบบ Isometric 
 

 
 
รูปที่ 3.16 แสดงหน้าต่างการเขียนแบบ Isometric 

 
3. ระบบพิกัดส าหรับการเขียนแบบ 

ในการเขียนแบบคอมพิวเตอร์ การก าหนดต าแหน่งที่ถูกต้องถือเป็นเร่ืองส าคัญมาก เพราะถ้าก าหนด
พิกัดผิด ผลงานที่ได้ก็จะผิดพลาดไปด้วยการก าหนดค่าพิกัดในการเขียนแบบสามารถท าได้ดังนี้ 
3.1 การก าหนดพิกัดโดยการใช้เมาส์ 

วิธีการโดยการเอาเมาส์ไปคลิกในต าแหน่งใดๆที่ต้องการใน Windows Area ของจอภาพ โดย
สามารถดูได้ว่าในขณะนั้น Cross Hair อยู่ ณ ต าแหน่งใดโดยการดูที่ Status Bar จะแสดงพิกัดตามแนวแกน 
X และแกน Y  
 

Crosshair cursor จะเปลี่ยนเป็น 

แบบ Isometric 



 
 
รูปที่ 3.17 แสดงพิกัดต าแหน่งที่ Status Bar 

จากรูป ณ ต าแหน่ง Cross Hair ขณะนี้ อยู่ที่ แกน X = 94.4810  แกน Y = 227.8960  หน่วยโดยอาจจะใช้ค่า
จุดทศนิยมให้น้อยกว่าสี่ต าแหน่งก็ได้โดยการปรับค่าที่ Drawing Units  ดังรูป 
 

 
 
รูปที่ 3.18 แสดงค่าจุดทศนิยมสองต าแหน่ง 
 

 

พิกัดต าแหน่งที่ Status Bar 

ต าแหน่ง Cross Hair 

 

ค่าจุดทศนิยมสองต าแหน่ง 

คลิก 



3.2 การก าหนดค่าพิกัดแบบ Absolute  
เป็นการก าหนดต าแหน่งโดยการอ้างอิงกับจุด 0,0 (จุด Origin) ของจอภาพ การก าหนดค่าพิกัดด้วย

วิธีนี้จะต้องป้อนค่าของแกน X และ Y ด้วยคีย์บอร์ด 
รูปแบบของการป้อนดังน้ี  X, Y  
 X คือค่าพิกัดในแนวแกน X 
 Y คือค่าพิกัดในแนวแกน Y 
โดยที่ค่าของแกนทั้งสองจะอ้างอิงกับจุดก าเนิด 0,0 (จุด Origin)  
ตัวอย่างที่ 3.1  
การเขียนรูปสี่เหลี่ยม A, B, C, D 
 ก าหนดให้ค่าพิกัดที่จุด A = 50, 50 จุด B = 200, 50 จุด C = 200,150 และจุด D = 50,150 

 
 
ล าดับขั้นของการปฏิบัติดังนี้ 
1. ที่ Menu bar คลิก File>New หรือที่ Tool Bar คลิกที่ Icon New 
 

 
 
รูปที่ 3.19 แสดงการเปิดไฟล์ใหม่ 

 
 
 
 
 
 

คลิก 



2. จะปรากฏไดอะล็อกบ็อก Create New Drawing เลือกหน่วยเป็น Metric คลิก OK 
 

        
 
รูปที่ 3.20 แสดงการเลือกหน่วยเป็น Metric 

 
3. จะได้ไฟล์เขียนแบบที่มีพื้นที่ในการเขียนแบบเป็น 420 X 297 มิลลิเมตร 
 

 
 
รูปที่ 3.21 แสดงไฟล์เขียนแบบ 

 

คลิก 

เลือก 

คลิก 



4. ที่ Menu bar คลิก Format >Units… จะปรากฏไดอะล็อกบ็อก Drawing Units เลือกทศนิยมเป็นสอง
ต าแหน่ง 

 
 
รูปที่ 3.22 แสดงการเลือกทศนิยม 

 ขั้นตอนการใช้ค าสั่งด้วย Command Line 
1. ที่ Command Line พิมพ์ Line กดแป้น Enter 
 

 
 
รูปที่ 3.23 แสดงการพิมพ์ค าสั่ง Line 

2. ที่ Command Line พิมพ์ ค่าของจุด A = 50, 50  กดแป้น Enter 
 

 
 

รูปที่ 3.24 แสดงการพิมพ์ค่าพิกัด 50, 50 
 

 
 

เลือก 

คลิก 

พิมพ ์Line 

พิมพ ์50, 50 



3. ที่ Command Line พิมพ์ ค่าของจุด B = 200, 50  กดแป้น Enter 
 

 
รูปที่ 3.25 แสดงการพิมพ์ค่าพิกัด 200, 50 

 
4. ที่ Command Line พิมพ์ ค่าของจุด C = 200,150  กดแป้น Enter 

 
รูปที่ 3.26 แสดงการพิมพ์ค่าพิกัด 200,250 

 
5. ที่ Command Line พิมพ์ ค่าของจุด D = 50,150  กดแป้น Enter 

 
รูปที่ 3.27 แสดงการพิมพ์ค่าพิกัด 50,150 

 
6. ที่ Command Line พิมพ์ C กดแป้น Enter 
 

 
รูปที่ 3.28 แสดงการพิมพ์ C 

 
 

พิมพ ์200, 50 

พิมพ ์200,250 

พิมพ ์50,150 

พิมพ ์C 



7. ได้รูปสี่เหลี่ยม ABCD ตามพิกัดที่ต้องการ 
 

 
 
รูปที่ 3.29 แสดงการเขียนรูปสี่เหลี่ยมพิกัดแบบ Absolute 

 
บทสรุป 

การก าหนดเงื่อนไขในการเขียนแบบ การก าหนดขอบเขตหรือพื้นที่ส าหรับเขียนแบบ การ
ก าหนดค่าหน่วย การก าหนดค่าของ Drafting Settings การเขียนภาพในแบบ Isometric ระบบพิกัดส าหรับ
การเขียนแบบและ ระบบพิกัด  UCS (User Coordinate System) เป็นสิ่งที่ส าคัญและจ าเป็นในการสร้างไฟล์
เขียนแบบใหม่ทุกครั้งที่จะต้องกระท าเป็นอันดับแรก 

 
 
 
 
 
 
 
 



 
ใบเนื้อหา  

เวลา 240 นาที วิชาการออกแบบโปรแกรมใช้คอมพิวเตอร์ช่วย     รหัสวิชา 3000-0206 
ชื่อหน่วย ค าสั่งประเภทเส้นโค้ง 

1. ค าสั่ง Arc 
ค าสั่ง Arc เป็นค าสั่งที่ใช้เขียนเส้นที่เป็นส่วนโค้งของวงกลมซึ่งสามารถก าหนดรัศมีตามแต่ผู้เขียน

จะก าหนดและใช้ในการเขียนส่วนโค้งของวัตถุ เช่นแผ่นเพล็ดเจาะรู หรือวงรอบของบานประตูหน้าต่าง การ
เขียนโดยการก าหนดจุด ความยาว และมุม 

ค าสั่งย่อยของค าสั่ง Arc  
1.1 ค าสั่ง Arc แบบ 3Point 

เมื่อต้องการสร้างเส้นโค้งที่ลากผ่านจุดต่างๆ 3 จุด 
ใบงานท่ี 5.1  

หน่วยที่ 5 
 

วิชาการออกแบบโปรแกรมใช้คอมพิวเตอร์ช่วย     รหัสวิชา 3000-0206 
ชื่อหน่วย ค าสั่งประเภทเส้นโค้ง 

 ค าสั่ง 
จงเขียนแบบให้ได้ขนาดและพิกัดโดยการใช้ค าสั่งค าสั่ง Arc แบบ 3Point 

 
 

ล าดับขั้นการปฏิบัติงาน 

1. ที่ Command Windows พิมพ์ Arc กดแป้น Enter 
2. ที่ Command Windows พิมพ์ค่าพิกัดจุด A เป็น 200,100 กดแป้น Enter 
3. ที่ Command Windows พิมพ์ค่าพิกัดจุด B เป็น 250,200 กดแป้น Enter 
4. ที่ Command Windows พิมพ์ค่าพิกัดจุด C เป็น 300,100 กดแป้น Enter 
 
       เคร่ืองมืออุปกรณ์ที่ใช้ 
1. ชุดเคร่ืองคอมพิวเตอร์ช่วยสอน 



2. เอกสารประกอบการสอนหน่วยที่ 5  
 

 
 

รูปที่ 5.1 แสดงการใช้ค าสั่ง 3Point 
 

 
 
 
 
 
 
 
 
 
 

 
 
 



 
1.2 ค าสั่ง Arc แบบ Start, Center, End 

เร่ิมจากก าหนดจุดเร่ิมต้นและจุดศูนย์กลางโค้ง เพื่อสร้างเป็นระยะรัศมีจนถึงจุดสิ้นสุดโค้งที่ก าหนด 
 

ใบงานท่ี 5.2  
หน่วยที่ 5 

 
วิชาการออกแบบโปรแกรมใช้คอมพิวเตอร์ช่วย     รหัสวิชา 3000-0206 

ชื่อหน่วย ค าสั่งประเภทเส้นโค้ง 
 ค าสั่ง 
จงเขียนแบบให้ได้ขนาดและพิกัดโดยการใช้ค าสั่งค าสั่ง Arc แบบ Start, Center, End 

 
 

ล าดับขั้นการปฏิบัติงาน 

1. ที่เมนูบาร์คลิกเลือก Draw > Arc > Start, Center, End  กดแป้น Enter 
2. ที่ Command Window พิมพ์ค่าพิกัดเร่ิมต้นจุด A เป็น 300,100 กดแป้น Enter 
3. ที่ Command Window พิมพ์ค่าพิกัดจุดศูนย์กลางจุด B เป็น 250,100 กดแป้น Enter 
4. ที่ Command Window พิมพ์ ค่าพิกัดจุดปลายจุด C เทียบกับแกน 0 องศา ทิศทวนเข็มนาฬิกา 
    เป็น@ 50<130 กดแป้น Enter 
 
       เคร่ืองมืออุปกรณ์ที่ใช้ 
1. ชุดเคร่ืองคอมพิวเตอร์ช่วยสอน 
2. เอกสารประกอบการสอนหน่วยที่ 5  
 



 
 

รูปที่ 5.2 แสดงการใช้ค าสั่ง Start, Center, End 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



1.3 ค าสั่ง Arc แบบ Start, Center, Angle  
เร่ิมจากการก าหนดจุดเร่ิมต้นโค้งและจุดศูนย์กลางโค้ง เพื่อสร้างเป็นระยะรัศมีในการเขียนโค้ง โดย

มุมที่ใช้ส าหรับการเขียนเส้นโค้งจะอ้างอิงจากทิศทางที่ก าหนดต้ังแต่เร่ิมเขียนแบบ 
 

ใบงานท่ี 5.3  
หน่วยที่ 5 

 
วิชาการออกแบบโปรแกรมใช้คอมพิวเตอร์ช่วย     รหัสวิชา 3000-0206 

ชื่อหน่วย ค าสั่งประเภทเส้นโค้ง 
 ค าสั่ง 
จงเขียนแบบให้ได้ขนาดและพิกัดโดยการใช้ค าสั่งค าสั่ง Arc แบบ Start, Center, Angle 

 
 

ล าดับขั้นการปฏิบัติงาน 

1. ที่เมนูบาร์คลิกเลือก Draw > Arc > Start, Center, Angle กดแป้น Enter 
2. ที่ Command Window พิมพ์ค่าพิกัดเร่ิมต้นจุด A เป็น 300,100 กดแป้น Enter 
3. ที่ Command Window พิมพ์ค่าพิกัดจุดศูนย์กลางจุด B เป็น 250,100 กดแป้น Enter 
4. ที่ Command Window พิมพ์ค่าองศาของมุมระหว่างจุดปลายส่วนโค้งทิศทวนเข็มนาฬิกาเป็น  
    270 กดแป้น Enter 
 
       เคร่ืองมืออุปกรณ์ที่ใช้ 
1. ชุดเคร่ืองคอมพิวเตอร์ช่วยสอน 
2. เอกสารประกอบการสอนหน่วยที่ 5  
 



 
 

รูปที่ 5.3 แสดงการใช้ค าสั่ง Start, Center, Angle 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



1.4 ค าสั่ง Arc แบบ Start, Center, Length  
เส้นโค้งที่เกิดขึ้นเร่ิมจากการก าหนดจุดเร่ิมต้นโค้งและจุดศูนย์กลางโค้ง เพื่อสร้างเป็นระยะรัศมีใน

การเขียนโค้ง แล้วก าหนดความยาวคอร์ดของวงกลมที่ต้องการ จะเกิดเส้นโค้งที่เขียนจากจุดเร่ิมต้นโค้งถึง
ปลายคอร์ด 
 

ใบงานท่ี 5.4  
หน่วยที่ 5 

 
วิชาการออกแบบโปรแกรมใช้คอมพิวเตอร์ช่วย     รหัสวิชา 3000-0206 

ชื่อหน่วย ค าสั่งประเภทเส้นโค้ง 
 ค าสั่ง 
จงเขียนแบบให้ได้ขนาดและพิกัดโดยการใช้ค าสั่ง ค าสั่ง Arc แบบ Start, Center, Length 

 
 

ล าดับขั้นการปฏิบัติงาน 

1. ที่เมนูบาร์คลิกเลือก Draw > Arc > Start, Center, Length กดแป้น Enter 
2. ที่ Command Window พิมพ์ค่าพิกัดเร่ิมต้นจุด A เป็น 100,100 กดแป้น Enter 
3. ที่ Command Window พิมพ์ค่าพิกัดจุดศูนย์กลางจุด B เป็น 200,100 กดแป้น Enter 
4. ที่ Command Window พิมพ์ ค่าความยาวคอร์ดของวงกลมเป็น 200 กดแป้น Enter 
 
       เคร่ืองมืออุปกรณ์ที่ใช้ 
1. ชุดเคร่ืองคอมพิวเตอร์ช่วยสอน 
2. เอกสารประกอบการสอนหน่วยที่ 5  
 
 
 
 



 
 

รูปที่ 5.4 แสดงการใช้ค าสั่ง Start, Center, Length 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



2. ค าสั่ง Circle 
เป็นค าสั่งที่ใช้ในการเขียนวงกลมซึ่งสามารถที่จะก าหนดวงกลมได้ทั้งความยาวของรัศมี หรือ

เส้นผ่าศูนย์กลาง โดยสามารถสร้างได้หลายวิธี โดยการก าหนดจุดที่ใช้ในการสร้างตามเงื่อนไขภายในค าสั่ง 
ค าสั่งย่อยของค าสั่ง Circle 

2.1 การเขียนวงกลมแบบ Center, Radius 
  เป็นการสร้างวงกลมด้วยการก าหนดจุดศูนย์กลางและความยาวของรัศมี 
 

ใบงานท่ี 5.5  
หน่วยที่ 5 

 
วิชาการออกแบบโปรแกรมใช้คอมพิวเตอร์ช่วย     รหัสวิชา 3000-0206 

ชื่อหน่วย ค าสั่งประเภทเส้นโค้ง 
 ค าสั่ง 
จงเขียนแบบให้ได้ขนาดและพิกัดโดยการใช้ค าสั่ง Center, Radius 

 
 

ล าดับขั้นการปฏิบัติงาน 

1. ที่Command Window พิมพ์ Circle กดแป้น Enter 
2. ที่Command Window พิมพ์จุดศูนย์กลางของวงกลมที่จุด A เป็น 150,150 กดแป้น 
   Enter 
3. ที่Command Window พิมพ์ค่ารัศมี (R) เป็น 100 กดแป้น Enter 
 
       เคร่ืองมืออุปกรณ์ที่ใช้ 
1. ชุดเคร่ืองคอมพิวเตอร์ช่วยสอน 
2. เอกสารประกอบการสอนหน่วยที่ 5  
 



 
 

รูปที่ 5.5 แสดงการใช้ค าสั่ง Center, Radius 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



2.2 การเขียนวงกลมแบบ Center, Diameter  
เป็นการก าหนดจุดศูนย์กลางและความยาวของเส้นผ่าศูนย์กลาง 

 
ใบงานท่ี 5.6  

หน่วยที่ 5 
 

วิชาการออกแบบโปรแกรมใช้คอมพิวเตอร์ช่วย     รหัสวิชา 3000-0206 
ชื่อหน่วย ค าสั่งประเภทเส้นโค้ง 

 ค าสั่ง 
จงเขียนแบบให้ได้ขนาดและพิกัดโดยการใช้ค าสั่ง Center, Diameter 

 
 

ล าดับขั้นการปฏิบัติงาน 

1. ที่ Command Window พิมพ์ Circle กดแป้น Enter 
2. ที่ Command Window พิมพ์จุดศูนย์กลางของวงกลมที่จุด A เป็น 150,150 กดแป้น Enter 
3. ที่ Command Window พิมพ์ D กดแป้น Enter 
4. ที่ Command Window พิมพ์ค่าเส้นผ่าศูนย์กลางเป็น 100 กดแป้น Enter   
 
       เคร่ืองมืออุปกรณ์ที่ใช้ 
1. ชุดเคร่ืองคอมพิวเตอร์ช่วยสอน 
2. เอกสารประกอบการสอนหน่วยที่ 5  
 



 
 

รูปที่ 5.6 แสดงการใช้ค าสั่ง Center, Diameter 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



ใบเนื้อหา  
เวลา 240 นาที วิชาการออกแบบโปรแกรมใช้คอมพิวเตอร์ช่วย     รหัสวิชา 3000-0206 

ชื่อหน่วย ค าสั่งประเภทเส้นโค้ง 
 
2.3 การเขียนวงกลมแบบ 2Point  

เป็นการเขียนวงกลมโดยการเขียนผ่าน 2 จุด 
 

ใบงานท่ี 5.7  
หน่วยที่ 5 

 
วิชาการออกแบบโปรแกรมใช้คอมพิวเตอร์ช่วย     รหัสวิชา 3000-0206 

ชื่อหน่วย ค าสั่งประเภทเส้นโค้ง 
 ค าสั่ง 
จงเขียนแบบให้ได้ขนาดและพิกัดโดยการใช้ค าสั่ง 2Point  
 

 
 

ล าดับขั้นการปฏิบัติงาน 

1. ที่ Command Windows พิมพ์ Circle กดแป้น Enter 
2. ที่ Command Windows พิมพ์ 2P กดแป้น Enter 
3. ที่ Command Windows พิมพ์ค่าจุด A เป็น 120,100 กดแป้น Enter 
4. ที่ Command Windows พิมพ์ค่าจุด B เป็น 200,150 กดแป้น Enter 
 
       เคร่ืองมืออุปกรณ์ที่ใช้ 
1. ชุดเคร่ืองคอมพิวเตอร์ช่วยสอน 
2. เอกสารประกอบการสอนหน่วยที่ 5  
 



 
 

รูปที่ 5.7 แสดงการใช้ค าสั่ง 2Point 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



2.4 การเขียนวงกลมแบบ 3Point  
เป็นการเขียนวงกลมโดยการเขียนผ่าน 3 จุด 

 
ใบงานท่ี 5.8  

หน่วยที่ 5 
 

วิชาการออกแบบโปรแกรมใช้คอมพิวเตอร์ช่วย     รหัสวิชา 3000-0206 
ชื่อหน่วย ค าสั่งประเภทเส้นโค้ง 

 ค าสั่ง 
จงเขียนแบบให้ได้ขนาดและพิกัดโดยการใช้ค าสั่ง 3Point  

 
 

ล าดับขั้นการปฏิบัติงาน 

1. ที่ Command Windows พิมพ์พิกัดจุดศูนย์กลางที่จุด A เป็น 200,150 
   กดแป้น Enter 
2. ที่ Command Windows พิมพ์พิกัดจุด B เป็น 120,100 กดแป้น Enter 
3. ที่ Command Windows พิมพ์พิกัดจุด C เป็น 250,80 กดแป้น Enter 
 
       เคร่ืองมืออุปกรณ์ที่ใช้ 
1. ชุดเคร่ืองคอมพิวเตอร์ช่วยสอน 
2. เอกสารประกอบการสอนหน่วยที่ 5  
 
 
 
 
 
 



 

 
 

รูปที่ 5.8 แสดงการใช้ค าสั่ง 3Point 
 

 
 
 
 
 
 
 
 
 
 
 

 
 
 



2.5 การเขียนวงกลมแบบ Tan, Tan, Radius  
เป็นการสร้างวงกลมด้วยการก าหนดจุดที่ต้องการให้วงกลมสัมผัสกับวัตถุจ านวน 2 จุด และความ

ยาวของรัศม ี   
ใบงานท่ี 5.9  

หน่วยที่ 5 
 

วิชาการออกแบบโปรแกรมใช้คอมพิวเตอร์ช่วย     รหัสวิชา 3000-0206 
ชื่อหน่วย ค าสั่งประเภทเส้นโค้ง 

 ค าสั่ง 
จงเขียนแบบให้ได้ขนาดและพิกัดโดยการใช้ค าสั่ง Tan, Tan, Radius 

 
ล าดับขั้นการปฏิบัติงาน 

1. ที่ Command Window สร้างเส้นตรงA พิมพ์ line กดแป้น Enter 
2. ที่ Command Window พิมพ์ค่าพิกัดจุดแรกเป็น 90,90 กดแป้น Enter 
3. ที่ Command Window พิมพ์ค่าจุดที่สองเป็น 170,170 กดแป้น Enter 
4. กดแป้น Enter เพื่อออกจากค าสั่ง 
5. ที่ Command Window สร้างเส้นตรง B พิมพ์ line กดแป้น Enter 
6. ที่ Command Window พิมพ์ค่าพิกัดจุดแรกเป็น 250,70 กดแป้น Enter 
7. ที่ Command Window พิมพ์ค่าจุดที่สองเป็น 210,160 กดแป้น Enter 
8. กดแป้น Enter เพื่อออกจากค าสั่ง 
9. ที่ Command Window พิมพ์ Circle กดแป้น Enter 
10. ที่ Command Window พิมพ์ Ttr กดแป้น Enter 
11. ใช้เมาส์คลิกที่เส้นตรง A 
12. ใช้เมาส์คลิกที่เส้นตรง B 
13. โปรแกรมจะค านวณระยะของรัศมีให้อัตโนมัติกดแป้น Enter จะได้วงกลมและออกจากค าสั่ง 
 
       เคร่ืองมืออุปกรณ์ที่ใช้ 
1. ชุดเคร่ืองคอมพิวเตอร์ช่วยสอน 
2. เอกสารประกอบการสอนหน่วยที่ 5  



 

 
 

รูปที่ 5.9 แสดงการใช้ค าสั่ง Tan, Tan, Radius 
 

 
 
 
 
 
 
 
 
 
 
 

 
 
 



2.6 การเขียนวงกลมแบบ Tan, Tan, Tan  
เป็นการสร้างวงกลมด้วยการก าหนดจุดที่ต้องการให้วงกลมสัมผัสจ านวน 3 จุด  

ใบงานท่ี 5.10  
หน่วยที่ 5 

 
วิชาการออกแบบโปรแกรมใช้คอมพิวเตอร์ช่วย     รหัสวิชา 3000-0206 

ชื่อหน่วย ค าสั่งประเภทเส้นโค้ง 
 ค าสั่ง  จงเขียนแบบให้ได้ขนาดและพิกัดโดยการใช้ค าสั่ง Tan, Tan, Tan 

 
ล าดับขั้นการปฏิบัติงาน 

1. ที่ Command Window สร้างเส้นตรง A พิมพ์ line กดแป้น Enter 
2. ที่ Command Window พิมพ์ค่าพิกัดจุดแรกเป็น 90,90 กดแป้น Enter 
3. ที่ Command Window พิมพ์ค่าจุดที่สองเป็น 170,170 กดแป้น Enter 
4. กดแป้น Enter เพื่อออกจากค าสั่ง 
5. ที่ Command Window สร้างเส้นตรง B พิมพ์ line กดแป้น Enter 
6. ที่ Command Window พิมพ์ค่าพิกัดจุดแรกเป็น 250,70 กดแป้น Enter 
7. ที่ Command Window พิมพ์ค่าจุดแรกเป็น 210,160 กดแป้น Enter 
8. กดแป้น Enter เพื่อออกจากค าสั่ง 
9. ที่ Command Window สร้างเส้น C พิมพ์ line กดแป้น Enter 
10. ที่ Command Window พิมพ์ค่าพิกัดจุดแรกเป็น 110,40 กดแป้น Enter 
11. ที่ Command Window พิมพ์ค่าจุดแรกเป็น 230,40 กดแป้น Enter 
12. กดแป้น Enter เพื่อออกจากค าสั่ง 
13. ที่ Draw Toolbar คลิก Tan, Tan, Tan 
14. ใช้เมาส์คลิกที่เส้นตรง A 
15. ใช้เมาส์คลิกที่เส้นตรง B 
16. ใช้เมาส์คลิกที่เส้นตรง C 
       เคร่ืองมืออุปกรณ์ที่ใช้ 
1. ชุดเคร่ืองคอมพิวเตอร์ช่วยสอน 
2. เอกสารประกอบการสอนหน่วยที่ 5  



 

 
 

รูปที่ 5.10 แสดงการใช้ค าสั่ง Tan, Tan, Tan 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 



3. ค าสั่ง Donut 
ใช้ในการเขียนเส้นวงกลมที่มีความหนาลักษณะเหมือนกับ Donut โดยการก าหนดขนาดของ

เส้นผ่าศูนย์กลางภายในและภายนอก 
 

ใบงานท่ี 5.11  
หน่วยที่ 5 

 
วิชาการออกแบบโปรแกรมใช้คอมพิวเตอร์ช่วย     รหัสวิชา 3000-0206 

ชื่อหน่วย ค าสั่งประเภทเส้นโค้ง 
 ค าสั่ง 
จงเขียนแบบให้ได้ขนาดและพิกัดโดยการใช้ค าสั่ง Donut  

 
 

ล าดับขั้นการปฏิบัติงาน 

1. ที่ Command Window พิมพ์ Donut กดแป้น Enter 
2. ที่ Command Window พิมพ์ค่าเส้นผ่าศูนย์กลางภายในเป็น 50 กดแป้น Enter 
3. ที่ Command Window พิมพ์ค่าเส้นผ่าศูนย์กลางภายนอกเป็น 70 กดแป้น Enter  
4. ที่ Command Window พิมพ์พิกัดจุด A เป็น 100,100 กดแป้น Enter 
5. ที่ Command Window พิมพ์พิกัดจุด B เป็น 250,100 กดแป้น Enter 
6. ที่ Command Window พิมพ์พิกัดจุด C เป็น 170,50 กดแป้น Enter 
6. กดแป้น Enter เพื่อออกจากค าสั่ง 
 
       เคร่ืองมืออุปกรณ์ที่ใช้ 
1. ชุดเคร่ืองคอมพิวเตอร์ช่วยสอน 
2. เอกสารประกอบการสอนหน่วยที่ 5  
 



 
 

รูปที่ 5.11 แสดงการใช้ค าสั่ง Donut 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



4. ค าสั่ง Spline 
เป็นค าสั่งที่ใช้ในการเขียนเส้นอิสระ Free Form ซึ่งเป็นเส้นที่มีความโค้งมนและสามารถเขียนได้ทั้ง

เส้นเปิดหรือเส้นที่ปิดเข้าหาจุดแรก โดยสามารถสร้างจุดได้มากและต่อเน่ือง 
การเข้าสู่ค าสั่ง Spline สามารถกระท าได้ดังนี้ 

 
ใบงานท่ี 5.12  

หน่วยที่ 5 
 

วิชาการออกแบบโปรแกรมใช้คอมพิวเตอร์ช่วย     รหัสวิชา 3000-0206 
ชื่อหน่วย ค าสั่งประเภทเส้นโค้ง 

 ค าสั่ง 
จงเขียนแบบให้ได้ขนาดและพิกัดโดยการใช้ค าสั่ง Spline 

 
 

ล าดับขั้นการปฏิบัติงาน 

1. ที่ Command Windows พิมพ์ Spline กดแป้น Enter 
2. คลิกเลือกต าแหน่งที่จุด A เป็น 50,100 กดแป้น Enter 
3. คลิกเลือกต าแหน่งที่จุด B เป็น 115,160 กดแป้น Enter 
4. คลิกเลือกต าแหน่งที่จุด C เป็น 180,50 กดแป้น Enter 
5. คลิกเลือกต าแหน่งที่จุด D เป็น 250,115 กดแป้น Enter 
6. คลิกเลือกต าแหน่งที่จุด E เป็น 350,50 กดแป้น Enter 
7. กดแป้น Enter 3 คร้ังเป็นการออกจากค าสั่ง 
 
       เคร่ืองมืออุปกรณ์ที่ใช้ 
1. ชุดเคร่ืองคอมพิวเตอร์ช่วยสอน 
2. เอกสารประกอบการสอนหน่วยที่ 5  
 



 
 

รูปที่ 5.12 แสดงการใช้ค าสั่ง Spline 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



5. ค าสั่ง Ellipse 
เป็นค าสั่งที่ใช้ในการเขียนรูปวงรีโดยการเขียนสามารถกระท าได้หลายวิธีโดยการก าหนดจุดที่จะใช้

ตามเงื่อนไข 
5.1 การเขียนวงรีแบบ Center  

วงรีเกิดจากการก าหนดจุดศูนย์กลางวงรี ตามด้วยระยะจากศูนย์กลางวงรีถึงจุดปลายของแกนวงรี
แกนที่ 1 และระยะจากจุดศูนย์กลางถึงจุดปลายของวงรีแกนที่ 2 
 

ใบงานท่ี 5.13  
หน่วยที่ 5 

 
วิชาการออกแบบโปรแกรมใช้คอมพิวเตอร์ช่วย     รหัสวิชา 3000-0206 

ชื่อหน่วย ค าสั่งประเภทเส้นโค้ง 
 ค าสั่ง 
จงเขียนแบบให้ได้ขนาดและพิกัดโดยการใช้ค าสั่ง Ellipse (Center) 

 
 

ล าดับขั้นการปฏิบัติงาน 

1. ที่เมนูบาร์คลิกเลือก Draw > Center  
2. ที่ Command Window พิมพ์ค่าเส้นผ่าศูนย์กลางจุด A เป็น 100,100 กดแป้น Enter 
3. ที่ ของCommand Window พิมพ์ระของแกนจุด B เป็น 230,100 กดแป้น Enter 
4. ที่ Command Window พิมพ์ระของแกนจุด C เป็น @30<90 กดแป้น Enter 
 
       เคร่ืองมืออุปกรณ์ที่ใช้ 
1. ชุดเคร่ืองคอมพิวเตอร์ช่วยสอน 
2. เอกสารประกอบการสอนหน่วยที่ 5  
 



 
 

รูปที่ 5.13 แสดงการใช้ค าสั่ง Center 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



5.2 การเขียนวงรีแบบ Axis, End  
วงรีเกิดขึ้นจากการก าหนดจุดปลายแกนทั้ง 2 ด้าน ของแกนวงรีแกนที่ 1 และจุดสุดท้าย คือระยะ

จากศูนย์กลางถึงจุดปลายของแกนที่ 2 
 

ใบงานท่ี 5.14  
หน่วยที่ 5 
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ชื่อหน่วย ค าสั่งประเภทเส้นโค้ง 
 ค าสั่ง 

จงเขียนแบบให้ได้ขนาดและพิกัดโดยการใช้ค าสั่ง Axis, End  

 
 

ล าดับขั้นการปฏิบัติงาน 

1. ที่เมนูบาร์คลิกเลือก Draw > Axis, End 
2. ที่ Command Window พิมพ์ จุดเร่ิมต้นเส้นแกนวงรีจุด A เป็น 50,100 กดแป้น Enter 
3. ที่ Command Window พิมพ์จุดปลายของแกนวงร่ีจุด B เป็น 300,100 กดแป้น Enter 
4. ที่ Command Window พิมพ์ระยะจากศูนย์กลางถึงจุดปลายของแกนที่สองจุด C เป็น 50  
    กดแป้น Enter 
 
 
       เคร่ืองมืออุปกรณ์ที่ใช้ 
1. ชุดเคร่ืองคอมพิวเตอร์ช่วยสอน 
2. เอกสารประกอบการสอนหน่วยที่ 5  
 
 
 
 



 

 
 

รูปที่ 5.14 แสดงการใช้ค าสั่ง Axis, End 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



5.3 การเขียนวงรีแบบ Arc 
เป็นการสร้างเส้นโค้งวงรี โดยเร่ิมจากการสร้างวงรีโดยก าหนดจุดปลายแกนทั้งสองด้านของแกน

วงรีแกนที่ 1 และจุดสุดท้ายระยะจากศูนย์กลางถึงจุดปลายของแกนวงรีแกนที่สองจะได้วงรี ส าหรับเส้นโค้ง
ที่เกิดขึ้นจะเป็นการก าหนดจุดเร่ิมต้นและจุดสิ้นสุดโค้งบนเส้นรอบรูปวงรี 
 

ใบงานท่ี 5.15  
หน่วยที่ 5 
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ชื่อหน่วย ค าสั่งประเภทเส้นโค้ง 
 ค าสั่ง 
จงเขียนแบบให้ได้ขนาดและพิกัดโดยการใช้ค าสั่งการเขียนวงรีแบบ Arc 

 
 

ล าดับขั้นการปฏิบัติงาน 

1. ที่เมนูบาร์คลิกเลือก Draw > Arc 
2. ที่ Command Window พิมพ์ จุดเร่ิมต้นเส้นแกนวงรีจุด A เป็น 40,110 กดแป้น Enter 
3. ที่ Command Window พิมพ์จุดปลายของแกนวงรีจุด B เป็น 280,110 กดแป้น Enter 
4. ที่ Command Window พิมพ์ระยะจากศูนย์กลางถึงจุดปลายของแกนที่สองเป็น 50 กดแป้น 
    Enter 
5. ที่ Command Window พิมพ์จุดเร่ิมต้นมุมที่ 0 องศากดแป้น Enter 
6. ที่ Command Window พิมพ์จุดปลายที่จุด C เป็น @50<270 กดแป้น Enter 
 
       เคร่ืองมืออุปกรณ์ที่ใช้ 
1. ชุดเคร่ืองคอมพิวเตอร์ช่วยสอน 
2. เอกสารประกอบการสอนหน่วยที่ 5  
 



 
 

รูปที่ 5.15 แสดงการใช้ค าสั่งวงรีแบบ Arc 
 

บทสรุป 
 การเขียนแบบงานที่มีลักษณะส่วนที่มีความโค้งมนหรือวงรีการศึกษาท าความเข้าใจเพิ่มทักษะ
ฝึกฝนการใช้ค าสั่ง ค าสั่ง Arc ซึ่งยังมีค าสั่งย่อยดังนี้ 
    1. 3Point 
    2. Start, Center, End 
    3. Start, Center, Angle  
    4. Start, Center, Length  
ค าสั่ง Circle, ค าสั่ง Donut, ค าสั่ง Spline และค าสั่ง Ellipse เป็นสิ่งส าคัญในการที่จะท าให้แบบงานที่เขียน
ออกมามีความถูกต้องสมบูรณ์ยิ่งขึ้น 
 
 
 
 
 


